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Introduction 

L’Association Intercommunale des Eaux du Condroz (AIEC -  http://www.eauxducondroz.be/) 
a en charge la production et la distribution d'eau potable dans le Condroz (Belgique) dans les 
5 communes de Ciney, Hamois, Havelange, Hotton et Somme-Leuze. 

L’AIEC est notamment amenée à cartographier les canalisations d’eau et divers éléments du 
réseau d’eau et à les positionner en prenant comme référence le Projet Informatique de 
Cartographie Continue (PICC) de la Wallonie. 

Ce manuel a pour vocation de guider les techniciens de l’AIEC dans leur prise en main du 
logiciel de cartographie libre QGIS pour mener à bien leur mission de cartographie.  

Les concepts et manipulations de données utiles aux techniciens de l’AIEC sont listés dans la 
table des matières de ce manuel.  

 

Temps nécessaire 

Le temps nécessaire pour parcourir ce manuel et réaliser les différentes manipulations 
présentées dépendra du niveau de départ de l’utilisateur dans QGIS : 

 Pour un utilisateur expert : 3 - 4 heures, voire moins. 

 Pour un utilisateur débutant mais ayant déjà une petite base SIG : 1 jour. 

 Pour un néophyte : 2 jours et plus. 
  

http://www.eauxducondroz.be/
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Ressources liées à ce manuel 

Accès aux ressources 

Ce manuel, les données qui y sont utilisées et les ressources complémentaires sont tous 
disponibles gratuitement via téléchargement à l’adresse web suivante :  
 

https://orbi.uliege.be/handle/2268/238464.  

Avant de commencer 

Placer le dossier téléchargé via l’adresse renseignée ci-dessus, « QGIS3.8.1 AIEC.zip », sur le 

disque dur de votre ordinateur. Eviter de le placer dans un répertoire trop long ou contenant 

des accents ou caractères spéciaux car cela pourrait faire planter QGIS lors de l’exécution de 

certaines fonctions. Attention, si vous le placez sur le bureau de l’ordinateur, le « nom 

d’utilisateur » de la session que vous utilisez ne doit pas contenir d’accents ou de caractères 

spéciaux car le répertoire correspondant au « bureau » reprend ce « nom d’utilisateur » 

(exemple en anglais du nom de répertoire d’un dossier créé sur le bureau: 

« C:\Users\Administrator\Desktop\New folder » où « Administrator » est le « nom 

d’utilisateur »). Dé-zippez ensuite ce dossier. 

Présentation des ressources 

La Figure 1 ci-dessous présente l’organisation et décrit le contenu du dossier de formation « 

QGIS3.8.1 AIEC ». 

 

Figure 1 : Organisation et description du contenu du dossier de formation « QGIS3.8.1 AIEC » 

 

Les données géographiques utilisées dans ce manuel et labellées « AIEC » proviennent de 

l’AIEC. 

https://orbi.uliege.be/handle/2268/238464
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* Les données du PICC ne sont pas disponible via le téléchargement sur ORBI étant donné 

qu’elles ne peuvent pas être redistribuées. Pour les obtenir, faire une demande au SPW via 

le géoportail de la Wallonie, en particulier via cette adresse: 

http://geoportail.wallonie.be/catalogue/b795de68-726c-4bdf-a62a-a42686aa5b6f.html. 

Ce manuel fait régulièrement référence au manuel de « Travaux pratiques sur les Systèmes 

d’Information Géographique - SIG - Initiation à QGIS » disponible dans le dossier de 

formation sous le nom de fichier « Initiation SIG QGIS Arlon Campus Environnement.pdf » 

et renseigné dans ce manuel comme « manuel de TP QGIS ». Les mises à jour plus récentes 

de ce manuel sont/seront disponibles ici : https://orbi.uliege.be/handle/2268/190559. 

Complément 

A titre d’information, voici un excellent tutoriel de SIG sous QGIS : 

 Tutoriel QGIS par UMR PASSAGES : http://ouvrir.passages.cnrs.fr/tutoqgis/index.php 

 

http://geoportail.wallonie.be/catalogue/b795de68-726c-4bdf-a62a-a42686aa5b6f.html
http://geoportail.wallonie.be/catalogue/b795de68-726c-4bdf-a62a-a42686aa5b6f.html
https://orbi.uliege.be/handle/2268/190559
http://ouvrir.passages.cnrs.fr/tutoqgis/index.php
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1. Télécharger et installer QGIS 

 
Le site web de QGIS : https://qgis.org/fr/site/ 
 
Pour télécharger QGIS, se rendre ici https://qgis.org/fr/site/forusers/download.html. 
 

 Choisissez la rubrique correspondant au système d’exploitation de votre ordinateur 
(Windows, Mac OS X, Linux, etc) 

 Pour Windows,  
o Il est conseillé de télécharger via les sous-rubriques « Installeurs autonomes 

pour les progiciels OSGeo4W » > « Dernière version (plus riche en 
fonctionnalités) ». Choisissez  64 ou 32 bit selon le type de système 
d’exploitation de votre ordinateur. 

 
Pour installer QGIS,  

 Une fois le setup téléchargé (~450 Mo), par exemple « QGIS-OSGeo4W-3.8.1-1-
Setup-x86_64.exe », installez-le en suivant une procédure classique d’installation 
logiciel (double clic sur le setup puis suivre les instructions). 

 
La version de QGIS utilisée pour réaliser ce manuel est « QGIS 3.8.1-Zanzibar ». 

 
 

https://qgis.org/fr/site/
https://qgis.org/fr/site/forusers/download.html
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2. Procédures dans QGIS 3.8.1 

2.1. Création et sauvegarde d’un nouveau projet QGIS 
 

La création d’un projet QGIS se fait assez simplement : 

 Démarrer QGIS via le menu « QGIS Desktop » 

 Une fois l’interface ouverte, cliquer sur « Projet > Nouveau » 

Un projet vierge apparait. 

Pour sauvegarder ce projet : 

 Cliquer sur « Projet > Enregistrer sous… » et naviguer vers le répertoire dans lequel 

vous désirez enregistrer votre projet.  

 Attention, il peut être intéressant que l’ensemble des données utilisées dans votre 

projet QGIS ET le fichier de projet QGIS en tant que tel (fichier avec l’extension 

« .qgz ») soient tous localisé dans un même dossier ou répertoire. Ceci facilitera une 

éventuelle migration de votre projet et des données y relatives vers un autre 

ordinateur ou disque dur et facilitera également leur envoi à un collègue. 

o Note : confer à ce propos la notion de chemin relatif et chemin absolu 

présentée à la section « 6.16. Enregistrement d’un projet QGIS : « chemin 

relatif » ou « chemin absolu » ? » page 141 et suivantes du manuel de TP 

QGIS pour en savoir plus. 

Dans le cadre de ce manuel, le projet QGIS est appelé « QGIS3.8.1 AIEC.qgz » et est placé 

dans le dossier « QGIS3.8.1 AIEC ». 

L’interface d’un nouveau projet QGIS ressemblera approximativement à celle présentée à la 

Figure 2 (celle de la Figure 2 est déjà quelque peu personnalisée). 
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Figure 2 : Interface de QGIS3.8.1 à l’ouverture d’un nouveau projet (en partie déjà personnalisée dans ce cas-
ci). 
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2.2. Paramétrage d’un nouveau projet QGIS 

 Système de Coordonnée de Référence (SCR) 2.2.1.

Dans tous projets de cartographie ou d’utilisation d’un SIG de manière générale, il est 

important de décider dans quel système de coordonnées le projet SIG et les couches de 

données géographiques seront exprimées. 

Dans ce cas-ci le système de coordonnées de référence est le système de coordonnées de 

référence utilisé par la Wallonie dans son géoportail « WalOnMap ». 

En particulier la couche de référence utilisée par l’AIEC est la couche « Projet Informatique 

de Cartographie Continue (PICC) », la référence cartographique numérique en 3 dimensions 

de l'ensemble de la Wallonie: 

 Fiche descriptive du PICC ici http://geoportail.wallonie.be/catalogue/b795de68-726c-

4bdf-a62a-a42686aa5b6f.html, dont l’onglet « Description » 

 Système de référence spatiale : « Belge 1972 / Belgian Lambert 72 (EPSG : 31370) » 

 

Le Système de Coordonnée de Référence (SCR) à utiliser est donc le « Belge 1972 / Belgian 
Lambert 72 (EPSG : 31370) ». 
 

Remarque :  

 Les différents SCR existants sont listés et décrits ici https://epsg.io/, par exemple 

https://epsg.io/31370. 

 Il existe un SCR belge plus récent, le SCR « Lambert belge 2008 (LB08) », « EPSG 

3812 ». 

o Informations ici : 

https://geoporta0il.wallonie.be/home/ressources/outils/Lambert-belge-

2008-LB08.html et ici https://epsg.io/3812 

o Cependant il semble ne pas encore être complétement opérationnel ou utilisé 

dans WalOnMap. 

Pour définir correctement le Système de Coordonnée de Référence (SCR) de votre nouveau 

projet QGIS, dans l’interface de votre projet QGIS : 

 Cliquer sur « Projet > Propriétés > SCR » et taper dans le menu de recherche de cette 

fenêtre « 31370 ». Le SCR d’intérêt apparait.  

o Remarque : pour avoir un aperçu des différents « SCR belges » disponibles 

dans QGIS, taper dans le menu de recherche « belge » ou « belgian » (Figure 

3). 

http://geoportail.wallonie.be/catalogue/b795de68-726c-4bdf-a62a-a42686aa5b6f.html
http://geoportail.wallonie.be/catalogue/b795de68-726c-4bdf-a62a-a42686aa5b6f.html
https://epsg.io/
https://epsg.io/31370
https://geoporta0il.wallonie.be/home/ressources/outils/Lambert-belge-2008-LB08.html
https://geoporta0il.wallonie.be/home/ressources/outils/Lambert-belge-2008-LB08.html
https://epsg.io/3812
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 Sélectionner ce SCR EPSG31370 comme SCR du projet QGIS 

 Cliquer sur « OK » 

 

Confer la section « 6.3. Créer un nouveau projet QGIS » page 36 et suivantes du manuel de 

TP QGIS pour en savoir plus à ce propos. 

 

 

Figure 3 : Propriétés du projet QGIS > SCR : choix du SCR EPSG 31370 Belge Lambert 72 

 Autres paramètres du projet QGIS 2.2.2.

D’autres paramètres du projet QGIS que le SCR peuvent être définis via le menu « Projet > 

Propriétés > Général » (Figure 4), en particulier : 

 Le mode d’enregistrement du projet en relatif ou en absolu (confer la Note ci-

dessus). Un projet QGIS est enregistré en mode relatif par défaut, ce qui est le cas du 

projet exemple « QGIS3.8.1 AIEC.qgz » disponible dans le dossier de formation. Le 

mode d’enregistrement relatif peut être conservé.  

 L’ellipsoïde (pour les calculs de distance et de surface) : c’est l’ellipsoïde 

« International 1909 (Hayford) » qui est associé à l’EPSG 31370 par défaut dans QGIS. 

Cet ellipsoïde sera automatiquement paramétré dans cette interface (propriétés du 

projet) lorsque l’EPSG 31370 est paramétré comme SCR du projet QGIS.  

o Remarque : l’ellipsoïde « Hayford 1924 » est associé à la projection Lambert 

1972 sur le site de l’IGN belge, ici http://www.ngi.be/FR/FR2-1-4.shtm. 

L’ellipsoïde « Hayford 1924 » n’est cependant pas disponible dans QGIS. 

http://www.ngi.be/FR/FR2-1-4.shtm
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Cependant, selon le « HelpDesk Carto » du géoportail de la Wallonie, « les 

valeurs de l'ellipsoïde de Hayford (1909) ont été adoptées par l'IUGG comme 

ellipsoïde de référence en 1924 à Madrid. Cet ellipsoïde porte donc 2 noms ». 

 Les unités pour les mesures de distances et superficie, mètres et mètres carrés par 

exemple dans ce cas-ci. 

 Les unités d’affichage de coordonnées sur la carte, « unités de carte (mètres) » dans 

ce cas-ci. 

 
Figure 4 : Paramétrages du projet QGIS via le menu « Propriétés du projet QGIS > Général » 
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2.3. Importation et correction des données AIEC dans QGIS  
Un set de données shapefile a été fourni par l’AIEC dans le dossier « DATA AIEC.zip ». Après 

une première ouverture dans QGIS, il apparait que ces données présentent 2 problèmes, 

décrits puis résolus ci-dessous. 

 

Problème 1 : 

 

Il semble y avoir un problème de codage de l’information contenue dans les tables 

d’attributs des fichiers shapefile, c’est-à-dire de l’information contenue dans les fichiers avec 

l’extension « .dbf ». Les caractères avec accents sont remplacés par des points 

d’interrogation « ? » dans QGIS (Figure 5). 

Ce problème provient du fait que les caractères avec accent ont été remplacés dans les 

fichiers originaux (fichiers « .dbf ») par des caractères spéciaux, comme cela peut se voir 

lorsque les fichiers « .dbf » sont ouverts directement avec Excel (Figure 6). 

 

Figure 5 : Problème de codage de l’information contenue dans les tables d’attributs (fichiers avec l’extension 
« .dbf ») des fichiers shapefile, ici ouvert dans QGIS. 
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Figure 6 : Problème de codage de l’information contenue dans les tables d’attributs (fichiers avec l’extension 
« .dbf ») des fichiers shapefile, ici ouvert dans EXCEL. 

 

 

Problème 2 : 

La plupart des shapefiles ne sont pas accompagnés du fichier contenant le système de 

coordonnées dans lequel est exprimée la couche d’information (fichier avec extension 

« .prj » (dans ArcGIS) ou « .qpj » (dans QGIS)), ce qui empêche leur utilisation directe tel 

quel. Le manque de cette information a pour conséquences que : 

 Un système de coordonnées par défaut (EPSG 4326), incorrect (bandeau orange 

dans la Figure 7), est appliqué aux shapefiles lorsqu’ils sont ajoutés dans l’interface 

QGIS. 

 Une transformation de datum non désirée est réalisée pour le projet QGIS (fenêtre 

d’avant plan dans la Figure 7) 
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Figure 7 : Problèmes apparaissant lors de l’ajout dans l’interface QGIS de fichiers shapefile dont le fichier 
« .prj » ou « .qpj » (contenant le système de coordonnées) est manquant. 

 

Correction des problèmes 1 et 2 

 

Le problème 1 a pu être résolu en ouvrant les fichiers shapefile dans ArcGIS, qui 

contrairement à QGIS, arrive à lire correctement les tables d’attributs des différentes 

couches.  

Le problème 2 a été résolu en utilisant dans ArcGIS la fonction « Define Projection (data 

management)» pour définir le système de coordonnées manquant de chaque shapefile. Il 

aurait pu être résolu dans QGIS via l’utilisation de la fonction « Définir la projection de la 

couche ». Le système de coordonnées utilisé est EPSG 31370. 

 

Le projet ArcGIS utilisé pour ces manipulations est le suivant : « QGIS3.8.1 AIEC\DATA AIEC 

CORRECTED\!DATA AIEC CORRECTION IN ARCGIS.mxd ». 

 

Une fois les fichiers shapefiles correctement lus dans ArcGIS et avec le bon système de 

coordonnées défini, les couches ont été exportées d’ArcGIS via « un clic droit sur la couche > 
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Data > Export data » et l’enregistrement des couches corrigées a été fait dans un nouveau 

dossier appelé « QGIS3.8.1 AIEC\DATA AIEC CORRECTED\CORRECTED EXPORTED\». Les 

couches contenues dans ce dossier ne posent plus aucun problème lors de leur utilisation 

dans QGIS. 

Ces couches ont été ajoutée dans le projet exemple QGIS « QGIS3.8.1 AIEC.qgz » dans le bloc 

de données appelé « DATA AIEC CORRECTED » (Figure 8). 

 

 

Figure 8 : Projet « QGIS3.8.1 AIEC.qgz » contenant les données shapefile corrigées dans le bloc de données 
appelé « DATA AIEC CORRECTED » et table d’attributs correctement reconnue. 
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2.4. Principe de connexion à des données en ligne 

 Accès aux données du géoportail de la Wallonie WalOnMap 2.4.1.

Le géoportail de la Wallonie, le site de référence de l'information géographique wallonne, 

est disponible ici http://geoportail.wallonie.be/home.html.  

En particulier, ce site dispose d’une carte interactive « WalOnMap » grâce à laquelle il est 

possible de visualiser et d’interagir avec les données géographiques de la Wallonie : 

http://geoportail.wallonie.be/walonmap.  

Nombre de données peuvent être obtenues en local via une demande au Service Public de 

Wallonie (SPW) et signature d’une licence de mise à disposition des données. Le délai 

d’obtention des données après demande peut être de quelques jours, voire semaines.  

 Accès au PICC - Le Projet Informatique de Cartographie 2.4.1.1.
Continue 

Plusieurs possibilités existent pour accéder au PICC et l’utiliser dans QGIS. Elles sont 

présentées ci-dessous. 

2.4.1.1.1. Accès au PICC via téléchargement en local d’une copie du 
PICC 

Le téléchargement en local d’une copie du PICC est probablement la meilleure manière de 

travailler avec le PICC dans QGIS car il permet de travailler plus rapidement avec cette 

donnée et cela ne nécessite pas de connexion internet une fois la donnée reçue. 

Pour obtenir une copie du PICC en local, il faut : 

 Se connecter au géoportail via la création d’un compte personnel (inscription). 

Confer le bouton « Se connecter » en haut à droite sur la page 

https://geoportail.wallonie.be/home.html. 

 Après connexion, se rendre à la page correspondant à la donnée d’intérêt, soit dans 

ce cas-ci le PICC. Pour se faire, faire une recherche dans le « catalogue des données 

et services » disponible ici https://geoportail.wallonie.be/catalogue-donnees-et-

services, en utilisant dans ce cas-ci le mot clef « PICC » dans le bandeau de recherche 

disponible dans le panneau latéral de gauche. Plusieurs versions du PICC existent 

dont (Figure 9) : 

o Une version de base 

o Une version améliorée destinée aux "partenaires WALTOPO" (PICC-vTOPO) 

Et sélectionner la donnée d’intérêt. 

 

http://geoportail.wallonie.be/home.html
http://geoportail.wallonie.be/walonmap
https://geoportail.wallonie.be/home.html
https://geoportail.wallonie.be/catalogue-donnees-et-services
https://geoportail.wallonie.be/catalogue-donnees-et-services
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Figure 9 : Recherche du PICC dans le « catalogue des données et services » du géoportail 
de la Wallonie. 

 

 Une fiche descriptive est disponible pour chaque donnée via le bouton « Fiche 

descriptive », par exemple pour le PICC de base ici 

https://geoportail.wallonie.be/catalogue/b795de68-726c-4bdf-a62a-

a42686aa5b6f.html. On peut notamment y lire : 

o « Le PICC reprend selon leurs coordonnées x, y, z, avec une précision inférieure 

à 25 cm, tous les éléments identifiables du paysage wallon. » 

o « 0.12 m en planimétrie et 0.25 m en altimétrie pour les éléments bien 

identifiables » (dans l’onglet « Qualité ») 

 Les différents modes d’accès à la donnée sont décrits dans l’onglet « Accès » de la 

fiche descriptive. 

 Pour télécharger le PICC en local, cliquer sur « Ajouter à mes téléchargements » puis 

rendez-vous en bas de l’onglet « Accès » de la fiche descriptive dans la section 

« Obtenir une copie de la donnée » et cliquer sur « finalisez votre demande de 

téléchargement. » 

 Paramétrer correctement les paramètres de demande de la copie de la donnée, par 

exemple (Figure 10) : 

https://geoportail.wallonie.be/catalogue/b795de68-726c-4bdf-a62a-a42686aa5b6f.html
https://geoportail.wallonie.be/catalogue/b795de68-726c-4bdf-a62a-a42686aa5b6f.html
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o Format des fichiers : ESRI shapefile 

o Système de coordonnées : Lambert Belge 72 

o Choisir le type de découpage : le plus simple est de définir la zone via la 

proposition « zone d’intérêt » du menu déroulant et de spécifier les 

coordonnées désirées, dans ce cas-ci en Lambert Belge 72 pour la zone 

d’action de l’AIEC : 

 X min : 195 000 

 X max : 230 000 

 Y Min : 100 000 

 Y max : 125 000 

 

Figure 10 : Définition de la zone d’intérêt de demande d’une copie du PICC dans 
WalOnMap, en coordonnées Lambert Belge 72. 

 

 Poursuivre ensuite la procédure en suivant les instructions à l’écran.  

La réception du PICC en local pour la zone a pris 8 jours lors d’une demande faite en juillet 

2019. 

Le dossier ZIP contenant la partie du PICC demandée sur la zone de l’AIEC pèse 165 Mo. Il 

contient 21 couches d’information. 

Le dossier peut ensuite être dézippé. Le dossier contenant les données dézippées est le 

dossier « QGIS AIEC\QGIS3.8.1 AIEC\PICC_ZONE_AIEC ».  
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Les données peuvent ensuite être ajoutées dans QGIS pour utilisation. Attention, il est 

conseillé, pour une bonne organisation des données et une facilité d’utilisation des données 

dans QGIS, de travailler avec des « groupes de données » dans la table des matières du 

projet QGIS (panneau latéral de gauche de l’interface de QGIS), groupes qui peuvent être 

renommés. Les données vectorielles sont traditionnellement classées en plaçant au niveau 

supérieur les points, puis les lignes, puis les polygones. Confer un aperçu du projet QGIS 

suite à l’ajout des données en local du PICC dans la Figure 11. 

 

Figure 11 : Aperçu de l’interface du projet QGIS après ajout des données corrigées de l’AIEC et des données 
du PIC en local avec zoom sur le village de Scy et symbologie par défaut de QGIS. 

 

Les données peuvent bien sur ensuite être activées/désactivées en mode visualisation et 

leurs symbologies changées, selon les besoins.  

Remarque :  

 Il n’existe pas actuellement de couche de symbologie QGIS (extension « .qml » dans 

QGIS, similaire au « .lyr » d’ArcGIS) pour les données du PICC. Le SPW a pour projet 

de créer ce type de couche pour QGIS à l’avenir. 

 Une conversion automatique d’une couche « .lyr » en une couche « .qml » ne peut se 

faire actuellement facilement avec des outils gratuits. Notons cependant l’existence 
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de l’extension « SLYR » (non testée) payante, développée par « North Road, confer 

https://north-road.com/slyr/.  

2.4.1.1.2. Accès au PICC dans QGIS via le service ESRI REST 

Dans QGIS (comme dans ArcGIS) il est possible d’accéder à des données disponibles sur un 

serveur via internet (via un « webservice »), sans avoir une copie des données en local. 

Différents types de webservices de mise à disposition des données via internet existent, en 

particulier, dans le géoportail de la Wallonie, les services WMS (Web Map Service) et ESRI-

REST (Figure 12). Confer l’onglet « Accès » des « Fiche descriptive » des données sur le 

géoportail.  

 

Figure 12 : Webservices d’accès aux données du PICC disponibles dans le géoportail de la Wallonie : WMS et 
ESRI-REST. 

 

Après quelques brefs  tests, il semblerait que le service ESRI-REST est plus rapide que le 

service WMS.  

Pour accéder au PICC via le webservice ESRI-REST dans QGIS : 

 Créer un groupe de données « PICC ESRI-REST » dans la table des matières du projet 

QGIS (facultatif) 

 Cliquer sur le bouton d’ajout de données dans QGIS « Gestionnaire des sources Open 

Data »  

 Utiliser le menu « Service de carte ArcGIS » 

 Demander une « nouvelle connexion » 

 Lui donner un nom, par exemple « PICC ESRI REST SERVICE CARTE ARCGIS » 

 Indiquer l’adresse URL disponible dans la fiche descriptive de la donnée dans la 

géoportail, dans ce cas-ci 

http://geoservices.wallonie.be/arcgis/rest/services/TOPOGRAPHIE/PICC_VDIFF/Map

Server (Figure 13) 

https://north-road.com/slyr/
http://geoservices.wallonie.be/arcgis/rest/services/TOPOGRAPHIE/PICC_VDIFF/MapServer
http://geoservices.wallonie.be/arcgis/rest/services/TOPOGRAPHIE/PICC_VDIFF/MapServer
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 Cliquer OK 

 

Figure 13 : Connexion au service de visualisation ESRI-REST pour le PICC depuis QGIS via le menu « Service de 
carte ArcGIS » de QGIS. 

 

 Cliquer sur « Connexion »  

 Sélectionner l’ensemble des données d’intérêt 

 Cliquer sur « Ajouter » puis « Fermer » 

 Les données se sont en principe ajoutées dans le projet QGIS AVEC LEGENDES 

COMPLETES ET CORRECTES dans la table des matières.  
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Figure 14 : Aperçu de l’interface du projet QGIS après ajout des données du PICC via  le service de 
visualisation ESRI-REST avec symbologie officielle et zoom sur le village de Scy. 

 

Remarque : l’utilisation du service ESRI-REST via le menu de QGIS « service d’entité ArcGIS » 

fonctionne mais au ralenti et l’ajout des différentes couches dans l’interface de QGIS doit se 

faire par étape. Cette solution semble peu performante. L’avantage potentiel de ce 

webservice est qu’il permet de se connecter à des couches d’information de type 

« vectoriel » (point, ligne, polygone) et non « image ». Ceci permet d’utiliser les options 

d’accrochage en mode édition (confer la section « 2.6.4 Accrochage ou snapping lors de 

l’édition »). Cependant il vaut mieux travailler avec une copie du PICC en local (qui est aussi 

en format vectoriel) pour éviter tout bug.  

2.4.1.1.3. Accès au PICC dans QGIS via le service WMS 

La connexion au PICC via le service WMS du géoportail (adresse URL : 

http://geoservices.wallonie.be/arcgis/services/TOPOGRAPHIE/PICC_VDIFF/MapServer/WMS

Server?request=GetCapabilities&service=WMS) fonctionne également. Cela résulte en 

l’ajout d’une seule couche d’information de type « image » avec la symbologie officielle du 

PICC (Figure 15). 

 

http://geoservices.wallonie.be/arcgis/services/TOPOGRAPHIE/PICC_VDIFF/MapServer/WMSServer?request=GetCapabilities&service=WMS
http://geoservices.wallonie.be/arcgis/services/TOPOGRAPHIE/PICC_VDIFF/MapServer/WMSServer?request=GetCapabilities&service=WMS
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Figure 15 : Aperçu de l’interface du projet QGIS après ajout des données du PICC via  le WMS avec 
symbologie officielle et zoom sur le village de Scy. 

2.4.1.1.4. Accès au PICC dans ArcGIS via une couche LYR 

Dans ArcGIS les mêmes possibilités de connexion que dans QGIS existent. En plus, il y a la 

possibilité d’utilisation d’une couche de type « LYR » (couche de symbologie d’ArcGIS). Pour 

ce faire : 

 Télécharger cette couche « LYR » via le menu nommé « Dans ArcGIS » de l’onglet « 

Accès » de la fiche descriptive du PICC sur le géoportail.  

 Une fois téléchargée, cette couche « TOPOGRAPHIE_PICC_VDIFF.lyr », disponible 

dans le dossier de formation à l’endroit « QGIS3.8.1 AIEC\DATA AIEC CORRECTED\ » 

peut être ajoutée dans un projet ArcGIS, ce qui ajoutera les données du PICC avec la 

symbologie officielle dans l’interface ArcMap. 

Remarque : cette couche « LYR » ne fonctionne pas dans QGIS.  
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 Accès au PPNC - Le Plan Photographique Numérique 2.4.1.2.
Communal ou « Orthophotos » 

Le même principe de connexion que celui présenté pour le PICC ci-dessus est valable pour le 

PPNC. 

 Description des différents jeux d’orthophotos : 

o http://geoportail.wallonie.be/georeferentiel/orthophotos  

 Fiche descriptive des orthophotos 2018 : 

o http://geoportail.wallonie.be/catalogue/71cb59f2-fb18-41bc-9dbf-

00ab93f69850.html 

 URL des 3 webservices existants :  

o ESRI-REST 

 Http://geoservices.wallonie.be/arcgis/rest/services/IMAGERIE/ORTHO
_2018/MapServer  

 Ajouté dans QGIS comme « service de carte ArcGIS » : fonctionne bien 
(Figure 16) 

o WMS : 

 http://geoservices.wallonie.be/arcgis/services/IMAGERIE/ORTHO_201

8/MapServer/WMSServer?request=GetCapabilities&service=WMS  

o WMTS (Web Map Tile Service): 

 http://geoservices.wallonie.be/arcgis/rest/services/IMAGERIE/ORTHO

_2018/MapServer/WMTS/1.0.0/WMTSCapabilities.xml  

http://geoportail.wallonie.be/georeferentiel/orthophotos
http://geoportail.wallonie.be/catalogue/71cb59f2-fb18-41bc-9dbf-00ab93f69850.html
http://geoportail.wallonie.be/catalogue/71cb59f2-fb18-41bc-9dbf-00ab93f69850.html
http://geoservices.wallonie.be/arcgis/rest/services/IMAGERIE/ORTHO_2018/MapServer
http://geoservices.wallonie.be/arcgis/rest/services/IMAGERIE/ORTHO_2018/MapServer
http://geoservices.wallonie.be/arcgis/services/IMAGERIE/ORTHO_2018/MapServer/WMSServer?request=GetCapabilities&service=WMS
http://geoservices.wallonie.be/arcgis/services/IMAGERIE/ORTHO_2018/MapServer/WMSServer?request=GetCapabilities&service=WMS
http://geoservices.wallonie.be/arcgis/rest/services/IMAGERIE/ORTHO_2018/MapServer/WMTS/1.0.0/WMTSCapabilities.xml
http://geoservices.wallonie.be/arcgis/rest/services/IMAGERIE/ORTHO_2018/MapServer/WMTS/1.0.0/WMTSCapabilities.xml
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Figure 16 : Aperçu de l’interface du projet QGIS après ajout des données du PPNC via  le webservice ESRI-
REST, avec zoom sur le village de Scy. 
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 Accès au plan de secteur 2.4.1.3.

Le même principe de connexion que celui présenté pour le PICC ci-dessus est valable pour le 

Plan de Secteur. 

 Fiche descriptive du plan de secteur : 

o https://geoportail.wallonie.be/catalogue/7fe2f305-1302-4297-b67e-

792f55acd834.html  

 URL du webservice ESRI-REST :  

o http://geoservices.wallonie.be/arcgis/rest/services/AMENAGEMENT_TERRIT
OIRE/PDS/MapServer 

o Ajouté dans QGIS comme « service de carte ArcGIS » : fonctionne bien (Figure 
17) 

 

 

Figure 17 : Aperçu de l’interface du projet QGIS après ajout des données du plan de secteur via  le webservice 
ESRI-REST, avec zoom sur le village de Scy. 

  

https://geoportail.wallonie.be/catalogue/7fe2f305-1302-4297-b67e-792f55acd834.html
https://geoportail.wallonie.be/catalogue/7fe2f305-1302-4297-b67e-792f55acd834.html
http://geoservices.wallonie.be/arcgis/rest/services/AMENAGEMENT_TERRITOIRE/PDS/MapServer
http://geoservices.wallonie.be/arcgis/rest/services/AMENAGEMENT_TERRITOIRE/PDS/MapServer
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 Accès au plan parcellaire cadastral 2.4.1.4.

Le même principe de connexion que celui présenté pour le PICC ci-dessus est valable pour le 

plan parcellaire cadastral. 

 Fiche descriptive du plan parcellaire cadastral 2018: 

o https://geoportail.wallonie.be/catalogue/bddd7785-6c9e-46cb-94f1-

c15bab0b3a59.html  

 URL du webservice ESRI-REST : 
o https://geoservices.wallonie.be/arcgis/rest/services/PLAN_REGLEMENT/CAD

MAP_2018_PARCELLES/MapServer  
o Ajouté dans QGIS comme « service de carte ArcGIS » : fonctionne bien (Figure 

18) 
 

 

Figure 18 : Aperçu de l’interface du projet QGIS après ajout des données du plan parcellaire cadastrale via  le 
webservice ESRI-REST, avec zoom sur le village de Scy. 

 

https://geoportail.wallonie.be/catalogue/bddd7785-6c9e-46cb-94f1-c15bab0b3a59.html
https://geoportail.wallonie.be/catalogue/bddd7785-6c9e-46cb-94f1-c15bab0b3a59.html
https://geoservices.wallonie.be/arcgis/rest/services/PLAN_REGLEMENT/CADMAP_2018_PARCELLES/MapServer
https://geoservices.wallonie.be/arcgis/rest/services/PLAN_REGLEMENT/CADMAP_2018_PARCELLES/MapServer
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 Accès à d’autres données en ligne dont des images 2.4.2.
satellites très haute résolution et divers fonds de carte 

Il est possible de se connecter à une multitude de services de données en ligne via QGIS. 

Voici 2 exemples. 

 XYZ tiles de QGIS 2.4.2.1.

Pour avoir accès dans QGIS, via un webservice, à une série de fonds de carte dont des 

images satellites très hautes résolution (ESRI, GOOGLE, BING) et d’autres types de carte 

(Google maps, OpenStreetMap, relief, etc, etc), procéder comme suit : 

 Dans l’interface QGIS, cliquer sur le bouton de la console Python  qui s’ouvrira 

dans l’interface 

 Se rendre sur la page web 

https://raw.githubusercontent.com/klakar/QGIS_resources/master/collections/Geos

upportsystem/python/qgis_basemaps.py 

o Copier l’ensemble du script dans le presse-papier 

 Coller l’ensemble du script dans la console Python de QGIS après les marques « >>> » 

dans la partie inférieure de la console. 

 Attendre quelques secondes que le code se soit correctement exécuté 

 Après, toujours dans la console, terminer en tapant la touche « enter » 

 Une série de services web est venue s’ajouter dans le menu accessible via le bouton 

« Gestionnaire des sources Open Data > Explorateur > XYZ Tiles » (Figure 19). 

 Ces services peuvent maintenant être ajoutés dans l’interface QGIS via ce même 

menu. 

 La console Python peut être fermée. 

 Cette manipulation ne doit se faire qu’une seule fois. Les webservices ajoutés 

resteront disponibles pour les futurs et anciens projets QGIS.  

https://raw.githubusercontent.com/klakar/QGIS_resources/master/collections/Geosupportsystem/python/qgis_basemaps.py
https://raw.githubusercontent.com/klakar/QGIS_resources/master/collections/Geosupportsystem/python/qgis_basemaps.py
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Figure 19 : Ajout d’une série de services web dans QGIS via la console Python et le bouton  « Gestionnaire 
des sources Open Data > Explorateur > XYZ Tiles ». 

 WMS et WFS, etc 2.4.2.2.

Plus d’information sur les webservices est disponible dans le manuel de TP QGIS à la section 

« 6.4.4. Ajouter des données disponibles via des « services web spatiaux » de types WMS, 

WFS, WCS » pages 50 et suivantes. 
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2.5. Création d’une couche shapefile 
Une nouvelle couche shapefile (point, ligne, polygone) peut être crée facilement dans QGIS 

via le bouton « Nouvelle couche shapefile » .  

Pour en savoir plus à ce propos, confer la section « 6.11.2. Créer de nouvelles données 

géographiques » pages 92 et suivantes du manuel de TP QGIS. 

Attention de bien définir le SCR du shapefile, le type d’entités (point, ligne, polygone) et les 

formats de colonnes de la table d’attributs.  

 

2.6. Edition de données géographiques (dessin, modification) 
Pour l’AIEC, le positionnement des entités cartographiés doit se faire avec une précision 
planimétrique (XY) de +/- 1 mètre. Les entités sont positionnées relativement au PICC. 
Cette section donne des indications sur la manière de dessiner, éditer, déplacer des entités 
spatiales vectorielles dans QGIS et les bonnes pratiques à respecter. 

 Echelle de travail et précision spatiale 2.6.1.

 

La précision du positionnement d’entités spatiales dessinées dans QGIS dépendra fortement 
de l’échelle à laquelle travaille l’opérateur. 
Voici à titre indicatif quelques échelles d’affichage dans QGIS et la précision spatiale 
correspondante, approximative et atteignable facilement lors de la numérisation. 
 

o ECHELLE 1/100 : précision de 50 cm facilement 
o ECHELLE 1/50 : précision de 25 cm facilement 
o ECHELLE 1/25 : précision de 10 cm facilement 
o ECHELLE 1/10 : précision de 5 cm facilement 

 
L’échelle numérique est visible en bas de l’interface QGIS, avec les coordonnées et le 
système de coordonnées. 
 
Une échelle graphique peut être affichée dans l’interface de QGIS via le menu « Vue > 
Décoration > Echelle graphique », à activer et paramétrer correctement. 
 
Pour positionner des entités spatiales relativement au PICC, il suffit d’afficher le PICC en 
fond de carte (confer ci-dessus), zoomer suffisamment à l’endroit voulu pour avoir la 
précision souhaitée (important !) et faire l’édition souhaitée. 
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 Outils d’édition 2.6.2.

Pour une introduction à l’édition de données géographiques vectorielles dans QGIS, voir la 

section « 6.11. Edition et création de données géographiques » pages 87 et suivantes des 

notes de TP QGIS. 

Les principaux outils disponibles sont repris ci-dessous : 

o « Vue > Barre d’outils > Barre d’outils de numérisation » 
 Numérisation de base 
 Permet de dessiner des entités de manière simple. 

 Sélectionner la couche à éditer dans la table des matières 

 Rentrer en édition et éditer 

 
 

o « Vue > Barre d’outils > Barre d’outils de numérisation avancée»  
 Numérisation avancée 
 Similaire au menu « Editer » 
 Pour déplacer des entités entière : 

 Sélection de l’entité ou des entités à déplacer : confer les outils de 
sélection présentés dans la section suivante 

 Outil « Déplacer l’entité » 
 

 
 

o  « Vue > Barre d’outils > Barre d’outils de forme » 
 Pour dessiner des courbes, cercles, ellipses, rectangles, polygones 

réguliers  
 

 
 

o Extensions d’édition (à installer via le menu « Extensions ») 
  « Vue > Barre d’outils > Digitizing tools » 

 Edition avancée ! 
 

 
 

o Menu « Vue > Panneau > Numérisation avancée »   
 Outils CAD (Computer-Aided Design) notamment pour des parallèles et 

perpendiculaires. 
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 Edition de la table d’attribut via menu déroulant 2.6.3.

L’édition de la table d’attribut dans QGIS se fait facilement, similairement à ce qui se fait 

dans ArcGIS. Attention que le contenu d’une colonne peut être conditionné par le format de 

cette colonne (texte, nombre, etc). Il faut donc toujours veiller à ce que le format des 

colonnes soit le plus adapté.  

Pour éviter les fautes de frappes et accélérer l’encodage des valeurs textuelles dans la table 

d’attributs, on peut utiliser des menus déroulants avec des valeurs prédéfinies (Figure 20).  

Pour obtenir un menu déroulant pour une colonne d’une table d’attribut, il faut : 

 Cliquer droit sur la couche > Propriétés > Formulaire d’attributs > Sélectionner le 

champ (la colonne, le « field ») d’intérêt > Type d’outil > Liste de valeurs > indiquer la 

liste des valeurs possibles et leur descriptions éventuelles (possibilité d’importation 

automatique à partir des valeurs déjà présentes dans la table). 

 Une fois la colonne paramétrée correctement, le menu déroulant apparaitra lors de 

l’édition. Pour le tester, rentrer en session d’édition sur la couche > créer 

éventuellement une nouvelle entité > édition de la colonne d’intérêt dans la table 

d’attribut  le menu déroulant devrait être disponible.  
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Figure 20 : Utilisation d’un menu déroulant pour faciliter l’encodage des valeurs textuelles dans la table 
d’attributs d’un shapefile dans QGIS. 

 

Remarque : il y a une erreur d’encodage dans le fichier « conduites_de.shp » : colonne 
« diamètre » et « matériaux » inversées pour une entité.  

 Accrochage ou snapping lors de l’édition 2.6.4.

Lors de l’édition d’entités spatiales devant se toucher (par exemple 2 lignes ou 2 polygones), 
pour une plus grande précision (une jonction parfaite sans « dépassement » et sans « trou » 
dans les entités) et pour plus de facilité, il est possible d’utiliser des fonctions de 
« snapping » ou d’« accrochage » des entités entre elles. 
 
Le paramétrage des fonctions d’accrochage se fait via les menus suivants : 

o « Vue > Barre d’outils > Accrochage »  

 
 

o « Projet > Options d’accrochage » 

 
 

o Ces 2 barres d’outils semblent redondantes et se synchronisent ! 
 L’accrochage peut être activé ou désactivé via l’aimant rouge 
 A paramétrer comme désiré : 

 Accrochage sommets seulement 

 Accrochage segments seulement 

 Accrochage sommets et segments 
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 Distance d’accrochage et unités 

 Couches à considérer pour l’accrochage 
o « Préférences > Options > Numérisation > Accrochage » 

 A paramétrer comme désiré !  

 Notamment le « Rayon de recherche pour l’édition des sommets », 
confer ci-dessous. 

 
Il est possible d’accrocher les entités d’une couche (lignes des conduites par exemple) par 
rapport aux entités d’une autre couche d’un autre type (polygones des constructions du 
PICC par exemple). Cela se paramètre facilement via la barre d’outils d’options d’accrochage.  
 
Il est également possible de réaliser un accrochage par rapport aux données vectorielles 
d’un webservice de type « service d’entité d’ArcGIS » utilisant lui-même par exemple le 
service ESRI-REST pour le PICC. Cependant cette solution semble peu performante (lente) et 
résulte parfois en bug de QGIS. 
 
Exercice 

 Un test peut être fait sur le fichier « conduites_de.shp » par exemple, pour corriger 
des conduites s’intersectant alors qu’elles ne devraient pas. 

o ATTENTION, il faut paramétrer correctement le paramètre suivant : 
« Préférences > Options > Numérisation > Accrochage > Rayon de recherche 
pour l’édition des sommets » et indiquer une valeur pratique en fonction de 
vos données. Cette valeur va définir à quelle distance d’un vertex (= un point 
constitutif) d’une entité vectoriel, QGIS va reconnaitre ce vertex et va donc 
autoriser sa modification. Une valeur de 0 va rendre impossible la sélection 
des vertex. Une valeur de 2 mètres peut convenir pour les données de l’AIEC 
pour une édition de précision à grande échelle.  

o Pour déplacer un vertex (ou un segment ou un ensemble de segments) : 
 Pour sélectionner le/les éléments à déplacer : utiliser l’outil de nœud 

avec un clic gauche de la souris, sélection par survol, suivi d’un lâcher 
du clic gauche de souris 

 Pour déplacer les éléments sélectionnés : clic gauche à proximité des 
éléments sélectionnés, lâcher le clic et déplacer la souris 

 Pour arrêter de déplacer les éléments : clic gauche et lâcher de clic 
gauche  

 Pour désactiver la sélection : clic droit  

 Pour reconnecter parfaitement des conduites qui s’intersectent (Figure 21), 
procéder comme suit : 

o Activer l’accrochage pour la couche « conduites » avec un seuil (tolérance) 
d’accrochage de 0.2 m par exemple (à adapter éventuellement) (aimant 
rouge) 

o Activer « l’accrochage aux intersections », ce qui permettra aux vertex à 
déplacer de s’accrocher directement aux intersections (et donc de ne plus 
« dépasser »).  

o Sélectionner le vertex à déplacer avec l’outil de nœud  
o Le déplacer à l’endroit désiré 
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o Désélectionner le vertex 

   
 

Figure 21 : Intersection non désirée entre 2 conduites et correction via accrochage automatique aux 
intersections. 

 

 Pour reconnecter parfaitement des conduites entre lesquelles il y aurait un espace 
non désiré procéder comme suit : 

o Activer l’accrochage pour la couche « conduites » avec un seuil (tolérance) 
d’accrochage de 0.2 m par exemple (à adapter éventuellement) (aimant 
rouge) 

o Optionnel : Activer « l’accrochage aux intersections », ce qui permettra aux 
vertex à déplacer de s’accrocher directement aux intersections (et donc de ne 
plus « dépasser »).  

o Sélectionner le vertex à déplacer avec l’outil de nœud  
o Il peut être utile le cas échéant de déplacer dans un premier temps le vertex  

à une distance plus grande que le seuil (tolérance) d’accrochage défini pour 
la/les couches d’intérêt de l’endroit auquel ce vertex devra se trouver en 
définitive (>0.2 m par exemple) 

o Déplacer le vertex à l’endroit désiré 
 

 Notez encore que la petite crois rouge apparaissant à l’extrémité d’un segment ou au 
milieu d’une ligne permet d’ajouter un vertex. 

 
L’activation de l’ « édition topologique » peut être intéressante lors du travail avec des 
polygones afin de déplacer en une seule opération des côtés communs à plusieurs 
polygones. 
 
Notez également la possibilité d’éviter les superpositions de polygones lors de leur création 
via les options d’accrochage d’une couche polygone via l’option « Avoid overlap ».  
 
Notez également l’existence du « Vérificateur de géométrie » (en anglais : « Geometry 
Checker ») qui est un outil potentiellement puissant de détection et de correction de la 
géométrie d’une couche vectorielle. Celui vous permettra par exemple d’identifier toutes les 
lignes qui s’intersectent au sein d’une couche de lignes. Confer 
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https://docs.qgis.org/3.4/en/docs/user_manual/plugins/core_plugins/plugins_geometry_ch
ecker.html#geometry-checker. 

  Cette extension est déjà installée dans QGIS3.8.1 mais doit être activée dans le 
menu de gestion des extensions de QGIS (case à cocher). Après activation, cette 
extension est disponible dans le menu vecteur. A tester selon l’objectif recherché. 

 
Notez aussi l’existence du “Vérificateur de topologie” qui s’active de la même manière que 
le « Vérificateur de géométrie ». Celui vous permettra par exemple d’identifier en 1 clic tous 
les nœuds (vertex) isolés au sein d’une couche de ligne (Figure 22). 
 

 
Figure 22 : Utilisation du « vérificateur de topologie » pour identifier facilement tous les « nœuds isolés » 
(points rouges) d’une couche vectorielle de ligne. 
 
Pour plus d’information sur les possibilités d’édition dans QGIS (numérisation, topologie, 
etc), voyez la documentation officielle de QGIS : 

 https://docs.qgis.org/3.4/en/docs/user_manual/working_with_vector/editing_geometry_att
ributes.html 

 
  

https://docs.qgis.org/3.4/en/docs/user_manual/plugins/core_plugins/plugins_geometry_checker.html#geometry-checker
https://docs.qgis.org/3.4/en/docs/user_manual/plugins/core_plugins/plugins_geometry_checker.html#geometry-checker
https://docs.qgis.org/3.4/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html
https://docs.qgis.org/3.4/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html
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2.7. Faire des requêtes simples de sélection d’entités 
spatiales 

 

Il est parfois intéressant de sélectionner un sous-ensemble des entités spatiales présentes 
dans un shapefile pour par exemple travailler sur ces entités de manière indépendante des 
autres ou de créer un nouveau fichier ne reprenant que ce sous-ensemble.  
 
Plusieurs méthodes existent pour sélectionner un sous-ensemble d’entités spatiales, comme 
indiqué à la section « 6.6. Sélectionner des données » page 57 du manuel de TP QGIS et 
repris dans les 3 sections ci-dessous. 
 
Exercice  

 Un petit exercice reprenant notamment les différents types de sélection est proposé 
en fin de section suivante. 

 Sélection manuelle interactive 2.7.1.

Confer la section « 6.6.1. Sélection simple » page 57 du manuel de TP QGIS. 

 Requête de sélection sur base de la table d’attributs 2.7.2.

Confer la section « 6.6.2. Sélection par attribut » page 58 du manuel de TP QGIS. 

 Requête de sélection sur base spatiale 2.7.3.

Confer la section « 6.6.3. Sélection par localisation » page 58 du manuel de TP QGIS. 

2.8. Calcul des aires, périmètres et longueurs d’entités 
spatiales 

Confer  la section « 6.10.3.3. Calculer des aires, périmètres, longueurs d’entités spatiales », 

page 82 et suivantes du manuel de TP QGIS. 

2.9. Outils statistiques 
Confer  la section « 6.10.1. Calculer des statistiques dans la table d’attributs » page 82 et 
suivantes du manuel de TP QGIS. 
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Exercice reprenant les méthodes de sélection et de calculs dans la table d’attributs. 
 
Objectif  

 Calculer la longueur totale des canalisations en fonte dans une zone donnée. 
 

Méthode 
1. Calcul des longueurs de chacune des canalisations 

a. Via l’ajout d’une colonne dans la table d’attributs (attention au format de la 
colonne) et l’outil de calcul des longueurs de la calculatrice de champ 

2. Sélection des canalisations dans une zone donnée : 
a. Sélection manuelle interactive, ou  
b. Sélection par localisation à l’aide d’une autre couche (une zone d’intérêt 

correspondant à une commune par exemple), ou 
c. Sélection par attribut si un attribut correspond au critère de sélection spatial 

3. Sélection des canalisations en fonte 
a. Sélection par attribut (enlever de la sélection actuelle les canalisations 

n’étant pas en fonte) 
4. Somme des longueurs pour les entités sélectionnées via l’outil « Montrer le résumé 

statistiques » en cochant l’option « Entité(s) sélectionnée(s) uniquement ». 
5. Remarque : l’outil situé dans le menu «Traitements > Boite à outils > analyse 

vectorielle/statistiques par catégorie » peut également être utilisé pour calculer des 
statistiques par catégories d’entités spatiales si les catégories sont présentent dans 
la table d’attributs. 
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2.10. Utiliser des coordonnées GPS 
Pour un positionnement « absolu » précis d’entités spatiales par GPS, il faut avoir un bon 
GPS au moment des relevés puis importer l’information dans QGIS. 
 
Pour plus de facilité, le GPS doit être configuré pour enregistrer les coordonnées dans le 
système de coordonnées cible, soit Belge Lambert 72 EPSG 31370. Si ce n’est pas le cas et 
que les données sont enregistrées dans un autre système de coordonnées (par exemple 
EPSG 4326 (WGS84)), un reprojection est toujours possible dans QGIS via la fonction 
« Reprojeter une couche ».  
 

Des données GPS peuvent être soit : 

 Directement importées en format shapefile depuis le GPS vers QGIS : solution la plus 

simple et la plus propre 

 Etre retranscrite à la main dans un cahier de terrain puis encodée dans une feuille 

Excel par exemple avant d’être importées dans QGIS comme couche shapefile de 

points : solution plus fastidieuse et présentant un risque d’erreur au moment de la 

retranscription des coordonnées. 

 Importer des données GPS directement à partir du GPS 2.10.1.

2 menus de QGIS sont intéressants pour la gestion des données GPS : 
o « Vecteur > Outils GPS » (Figure 23). 

 
Figure 23 : Interface de l’outil « Outils GPS » de QGIS 

 

o « Vue > Panneaux > Information GPS » (Figure 24). 
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Figure 24 : Interface de l’outil « Information GPS » de QGIS 

 

 Importer des données GPS à partir d’une table EXCEL 2.10.2.

 Pour importer facilement dans QGIS des coordonnées GPS reprises dans une table 
Excel, il faut que la table Excel respecte une série de contraintes : 
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 Voir à ce propos l’« Annexe 4 - Fiche technique pour l’importation de points XY 
(GPS par exemple) dans QGIS à partir d’un tableur », page 167-168 du manuel de 
TP QGIS. 

 Une fois la table Excel formatée correctement, il suffit d’utiliser la fonction « Créer 
une couche de points à partir d’une table » de QGIS. 

 Autres outils utiles 2.10.3.

 « Mesurer une longueur » (Figure 25) 

 « Identifier les entités »  

 « Préférences > Options > SCR » choix du SCR pour nouvelle couche et nouveau 
projets ! 

 

 
Figure 25 : Outils de mesures dans QGIS. 

 

2.11. L'application Qfield de Qgis (non détaillé dans ce 
manuel) 

Sur le terrain, l’AIEC reporte aussi les informations sur tablettes ou smartphones via 

l'application Qfield de Qgis. 

Extension “QField” 

 https://qfield.org/docs/fr/  

 

Extension “QField Sync” 

 Sync your projects to QField 

 This plugin allows syncing from QGIS to QField. It analyses the current project and 

suggests (and performs) actions needed to make the project working on QField. 

  

https://qfield.org/docs/fr/
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2.12. Présenter les résultats sous forme de cartes 
QGIS permet de réaliser des « cartes classiques » ou des « webmap » (c’est-à-dire des cartes 

interactives pour site web).  

 Carte classique 2.12.1.

Pour réaliser une « carte classique », confer la section « 6.17. Edition cartographique 

(réalisation de cartes) » page 147 et suivantes du manuel de TP QGIS. 

 Webmap 2.12.2.

Pour réaliser une « webmap » via QGIS la solution la plus facile semblait être via l’utilisation 

de l’extension « qgis2web » installable à partir du menu « Extensions > Installer/Gérer les 

extensions » de QGIS. Une autre extension de création de webmap est « QGIS Cloud 

Plugin ». Ces extensions se développent assez dynamiquement actuellement et une 

réévaluation serait nécessaire afin de définir laquelle est actuellement la plus performante.  

2.13. Autres outils du géoportail de la Wallonie 

 L’extension expérimentale « WalGeoLocalisation - SPW : 2.13.1.
3.0 » 

« Extension QGIS qui permet de retrouver et visualiser les coordonnées géographiques d'une 

adresse, d'un lieu ou d'une commune qui se trouvent sur le territoire wallon. Il est 

également possible d'effectuer une recherche inversée pour obtenir une adresse par un 

simple clic sur la carte ou via les coordonnées d'un point. Ces coordonnées doivent être dans 

le système de projection Lambert Belge 72 (ESPG:31370). » 

Description de l’extension ici : 

 http://geoportail.wallonie.be/extensionsQGIS  

Pour installer cette extension, suivre les indications reprises sur le lien ci-dessus. L’adresse 

http://geoportail.wallonie.be/files/Ressources/Outils/QGIS/Plugins/plugins.xml est à ajouter 

dans les « Paramètres » du menu « Extensions » de QGIS. Confer Figure 26. 

http://geoportail.wallonie.be/extensionsQGIS
http://geoportail.wallonie.be/files/Ressources/Outils/QGIS/Plugins/plugins.xml
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Figure 26 : Ajout de l’extension expérimentale « WalGeoLocalisation - SPW : 3.0 » dans 
QGIS. 

 Metawal 2.13.2.

 

Metawal permet aux gestionnaires de données, de cartes et de services web de documenter 

de façon normalisée leurs ressources géographiques. Une fois la fiche encodée, les 

métadonnées peuvent être exploitées par différents outils (logiciels SIG, portails, sites web, 

etc.). 

o http://geoportail.wallonie.be/metawal 

 

Se renseigner sur le cahier des charges à respecter pour que les données créées par l’AIEC 

soient de qualité acceptable pour être intégrées dans le PICC ou autre base de donnée du 

SPW?  

 Autres outils 2.13.3.

Confer http://geoportail.wallonie.be/outils 

http://geoportail.wallonie.be/metawal
http://geoportail.wallonie.be/outils

